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About vRealize Network Insight
Installation Guide

The vRealize Network Insight Installation Guide is intended for administrators or specialists responsible
for installing vRealize Network Insight.

Intended Audience
This information is intended for administrators or specialists responsible for installing
vRealize Network Insight. The information is written for experienced virtual machine administrators who
are familiar with enterprise management applications and datacenter operations.

VMware Technical Publications Glossary
VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For
definitions of terms as they are used in VMware technical documentation, go to 
http://www.vmware.com/support/pubs.
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Preparing for Installation 1
Before you install vRealize Network Insight, prepare the deployment environment to meet the system
requirements.

This chapter includes the following topics:

n System Requirements

n Supported Products and Versions

System Requirements
Ensure that the system meets the minimum hardware configurations to install vRealize Network Insight.

Minimum Resource Requirements
n vRealize Network Insight Platform OVA

n 800 GB - HDD, Thin provisioned

n Medium Brick Requirement

n 8 cores - Reservation 4096 Mhz

n 32 GB RAM - Reservation - 16GB

n Large Brick Requirement

n 12 cores - Reservation 6144 Mhz

n 48 GB RAM - Reservation - 24GB

n vRealize Network Insight Proxy OVA

n 150 GB - HDD, Thin provisioned

n Medium Brick Requirement

n 4 cores - Reservation 2048 Mhz

n 10 GB RAM - Reservation - 5GB

n Large Brick Requirement

n 6 cores - Reservation 3072 Mhz
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n 12 GB RAM - Reservation - 6GB

Software Requirements
n Google Chrome or Mozilla Firefox Web browser

Privileges Required for Data Sources
n Privileges required to configure and use IPFIX

n vCenter Server Credentials with privileges:

n Distributed Switch: Modify

n dvPort group: Modify

n The predefined roles in the vCenter server must have the following privileges assigned at root
level that need to be propagated to the children roles:

n System.Anonymous

n System.Read

n System.View

n global.settings

n Privileges required for NSX Manager Data Provider

n NSX Manager Data Provider requires the Enterprise role.

n If Central CLI is enabled, then the system admin credentials are required for NSX Manager Data
Provider.

n User privileges required on Cisco switches for metrics collection

n vRealize Network Insight is capable of collecting metric data via SNMP as well as configuration
via SSH from Cisco Switches. Cisco Switches UCS platform requires the use of both SSH and
API for collection.

Table 1‑1.  
Type of data User Privileges

Configuration Data Read-Only

Metric Data SNMP read-only

SNMPv2 read-only SNMP community

SNMPv3 read-only

Brick Sizes
The hardware requirements of various brick sizes for a single platform and a single proxy VM are as
follows:
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Table 1‑2.  

Type Brick Size

Capacity
(Number
of
Managed
VMs)

Flows (# of
4-Tuples)

Flow
Records/IP
FIX

vCPU
Cores RAM

Disk (Thin
provisione
d) IOPS

Platform
(With flows)

LARGE 6K 2M 12 48 GB 800 GB 250

Platform
Without
flows)

LARGE 10K 12 48 GB 800 GB 250

Platform
(With flows)

MEDIUM 3K 1M 8 32 GB 800 GB 150

Platform
( Without
flows)

MEDIUM 5K 8 32 GB 800 GB 150

Proxy (With
flows)

LARGE 6K 100k/s 6 12 GB 150 GB 75

Proxy
(Without
flows)

LARGE 10K 6 12 GB 150 GB 75

Proxy (With
flows)

MEDIUM 3K 50k/s 4 10 GB 150 GB 50

Proxy
(Without
flows)

MEDIUM 5K 4 10 GB 150 GB 50

Network Communication Ports

The following table lists the ports and the protocols that are used for the network communication in
vRealize Network Insight:

Table 1‑3.  

Purpose From To Port Protocol

Communication
between the VMs of
vRealize Network
Insight

Collector Platform 443 HTTPS

Services that require
Internet access

Platform and Collector svc.ni.vmware.com 443 HTTPS

support2.ni.vmware.co
m

reg.ni.vmware.com

Communication for
miscellaneous services
configured

Platform LDAP server 389, 636 LDAP and LDAPS

SNMP server Configurable SNMP
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Table 1‑3.  (Continued)

Purpose From To Port Protocol

Platform and Collector DNS server 53 UDP

Syslog server Configurable

ESXi Hosts Collector 2055

Communication with
AWS as a data source

Collector AWS(*.amazonaws.co
m)

443 HTTPS

Communication with
other data sources
within the data center

Collector Arista switches 161 and 22 SNMP and SSH

Brocade switches 161 and 22 SNMP and SSH

Check the Point firewall 443 HTTPS

Cisco Nexus 161 and 22 SNMP and SSH

Cisco UCS (Unified
Computing System)

161, 22, and 443 SNMP, SSH, and
HTTPS

Cisco Catalyst
switches

161 and 22 SNMP and SSH

Dell switches 161 and 22 SNMP and SSH

HP 22 SSH

Juniper Switches 161 and 22 SNMP and SSH

Palo Alto Networks 443 HTTPS

VMware vSphere 443 HTTPS

VMware NSX 22 and 443 SSH and HTTPS

Supported Products and Versions
vRealize Network Insight supports several products and versions.

Data Source Version/Model Connection Protocol Permissions/Privileges

Amazon Web
Services
(Enterprise
License Only)

Not Applicable HTTPS Refer the Adding an AWS Data
Source section in the vRealize
Network Insight User Guide.

Arista switches 7050TX, 7250QX,
7050QX-32S, 7280SE-72

SSH, SNMP Read only user

Read only SNMP user

Brocade Switches VDX 6740, VDX 6940, MLX,
MLXe

SSH, SNMP Read only user

Read only SNMP user
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Data Source Version/Model Connection Protocol Permissions/Privileges

Check Point
Firewall

Check Point R80 HTTPS Administrator with Read Write
permissions

The Check Point Management
Server should accept API access
from the Collector IP address. It
can be set up from Manage &
Settings > Blades > Management
API > Advanced Settings.

Cisco Catalyst 3000, 3750, 4500, 6000, 6500 SSH, SNMP Read only SNMP user with default
privilege level 15

Cisco Nexus 5000, 7000, 9000, VSM
N1000

SSH, SNMP Read only user

Read only SNMP user

Cisco UCS
(Unified
Computing
System)

Series B blade servers,
Series C rack servers,
Chassis, Fabric interconnect

UCS Manager: HTTPS

UCS Fabric: SSH, SNMP

Read only user

Read only SNMP user

Dell switches FORCE10 MXL 10,
FORCE10 S6000, S4048,
Z9100, S4810,
PowerConnect 8024

SSH, SNMP Read only user

Read only SNMP user

HP HP Virtual Connect Manager
4.41, HP OneView 3.0

HP OneView 3.0: HTTPS

HP Virtual Connect Manager 4.41:
SSH

Read only user

Infoblox Infoblox NIOS version 8.0,
8.1, 8.2

HTTPS Read only user with API Interface
access

Read-only permissions for DNS
object types as follows:
n Permission Type - DNS
n Resource - A Records, DNS

Zones, DNS Views

Juniper Switches EX3300, QFX 51xx Series
(JunOS v12 & v15, without
QFabric)

Netconf, SSH, SNMP Read only user

Read only SNMP user

Palo Alto Networks Panorama 7.0.x, 7.1, 8.0 HTTPS Read only user

Admin role profile is required for
an administrator.

VMware NSX-V Supported Versions SSH, HTTPS NSX Manager Data Provider
requires the Enterprise role.

For 6.2.x & 6.3.x if Central CLI is
used, then provide system admin
credentials.
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Data Source Version/Model Connection Protocol Permissions/Privileges

VMware NSX-T Supported Versions HTTPS Read only user

VMware vSphere Supported Versions

For IPFIX, VMware ESXi
version needed:
n 5.5 Update 2 (Build

2068190) and above
n 6.0 Update 1b (Build

3380124) and above
n VMware VDS 5.5 and

above

Note   VMware tools should
be installed on all the virtual
machines in the data center
to identify the VM to VM path.

HTTPS Read only user

Privileges required to configure and
use IPFIX

vCenter Server Credentials with
privileges:

Distributed Switch: Modify

dvPort group: Modify

The predefined roles in the vCenter
server must have the following
privileges assigned at root level
that need to be propagated to the
children roles:

System.Anonymous

System.Read

System.View

global.settings
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Installing
vRealize Network Insight 2
You can deploy vRealize Network Insight using vSphere Web client or vSphere Windows native client.

Note   After you successfully deploy vRealize Network Insight Platform OVA, verify whether the given
static IP is set on vCenter Server.

This chapter includes the following topics:
n Installation Workflow

n Deploying vRealize Network Insight Platform OVA

n Activating the License

n Generating Shared Secret

n Setting up vRealize Network Insight Proxy Virtual Appliance (OVA)

n Deploy Additional Proxy to an Existing Setup

n Default Login Credentials

n NSX Assessment Mode for Evaluation License

n Add vCenter Server

n Analyze Traffic Flows

n Generate a Report

n Adding Data Sources

Installation Workflow
To install vRealize Network Insight, you install the platform OVA, activate the license, generate shared
secret, and setup proxy OVA.

Note   The terms Proxy and Collector are used interchangeably in the documentation.
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Deploying vRealize Network Insight Platform OVA
You can import the vRealize Network Insight Platform OVA to your vCenter Server.

Deployment using vSphere Web Client
You can deploy vRealize Network Insight using vSphere Web Client.

Procedure

1 Right-click the Datacenter where you want to install the appliance and select Deploy OVF Template.

2 Browse to select the source location of the appliance OVA.

3 Select the destination folder in which you want to create the VM and give a desired name to the VM.

4 Select a Host/Cluster where you want to run the deployed template.

5 Select the Resource Pool in which you want to deploy this template.

6 Verify the OVF template details.

7 Read the End User License Agreement and click Accept.

8 Select Deployment Configuration. Click Next.

9 Select the Datastore where you want to store the files. Click Next.

Installing vRealize Network Insight
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10 Select Thin Provision as the Virtual Disk format.

11 Select the network that the deployed VM will use.

The selected network should allow the appliance to reach out to Internet for support and upgrade.

12 Customize the template as mentioned below:

a (Optional) Web Proxy IP/FQDN and Web Proxy Port: For accessing the Internet using a proxy

b Select the Health Telemetry Enable check box to improve the product by sending anonymous
data about product performance.

c IPv4 Address: First reserved static IP address

d Netmask: Subnet mask for the above static IP

e Gateway: Default gateway of your network

f DNS Server List: DNS servers of your environment

g (Optional) Domain Search List: Determines which domain to be appended for dns lookups.

h NTP Server List: Enter the list of NTP servers and ensure that NTP Server can be reached from
the VM. The services will fail to start if NTP time is out of sync.

13 Review the details and click Finish.

14 Switch on the VM manually after the deployment.

Deployment Using vSphere Windows Native Client
You can deploy vRealize Network Insight using vSphere Windows native client.

Procedure

1 Click File > Deploy OVF Template.

2 Enter the URL to download and install the OVA package from the internet or browse to select the
source location of the OVA package on your computer.

3 Click Next and verify the OVF template details.

4 Read the End-User License Agreement and click Accept.

5 Provide a name and specify the location for the deployed template. Click Next.

6 Select the Deployment Configuration.

7 Select a Host/Cluster where you want to run the deployed template.

8 Select the Resource Pool in which you want to deploy this template.

9 Select a destination storage for the VM files. Click Next.

10 Specify the format in which you want to store the virtual disks. the Select Thin Provision as the
virtual disk format. Click Next.
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11 Specify the network that the deployed template should use. Map the network from OVA to your
inventory.

12 Customize the template for the deployment. Provide the shared secret that was generated on the
onboarding page. You will have to manually configure the appliance using the VM console. Click
Next.

13 Verify all the configuration data. Check Power on after deployment. Click Finish.

14 Once the Collector OVA is installed, start the VM and launch the console.

15 Log in with the given console credentials. Run the setup command.

16 Create the password for the support login. Change the password for the consoleuser.

17 Enter the following details to configure the network:

a IPv4 Address: Second reserved static IP address

b Netmask: Subnet mask for the above static IP

c Default Gateway: Default gateway of your network

d DNS : DNS server of your environment

Note   For multiple DNS servers, ensure that they are separated by space.

e Domain Search List : The domain that needs to be appended for dns lookup.

f Enter y to save the configuration.

18 Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start if NTP
time is out of sync.

Note   For multiple NTP servers, ensure that they are separated by commas.

19 A check is made to see if the shared secret key has been configured. The proxy is paired with the
corresponding platform. This may take few minutes.

20 To configure Web proxy, enter y. This is an optional configuration.

21 To configure Health Telemetry, enter y. This is an optional configuration.

22 All the services are verified.

Generating the Support Tunnel Certificate
Perform this step only if you are offline or have restricted access to Internet.

To generate the support tunnel certificate:

1 Log on to the console user CLI and run the offline-registration command.

2 The CLI generates a token. After you supply this token to VMware Support, an entry is created in the
registration server and a certificate is given to you.

3 Install this certificate by using the offline-registration command.

Installing vRealize Network Insight
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Activating the License
After installing the vRealize Network Insight Platform OVA, open https://<vRealize Network Insight
Platform IP address> in the Chrome Web browser.

Procedure

1 Enter the license key received in the welcome email.

2 For UI admin (admin@local) user name, set the password. If you are a support user or a CLI user,
refer Default Login Credentialsfor the password.

3 Click Activate.

4 Add the vRealize Network Insight Collector after activating the license.

Generating Shared Secret
You can generate and import the vRealize Network Insight proxy virtual appliance.

Generate a shared secret and import the vRealize Network Insight proxy virtual appliance:

Procedure

1 Generate a shared secret after activating the license on the Setup Proxy Virtual Appliance page.

2 Copy the shared secret.

You will require this during the deployment of vRealize Network Insight Proxy OVA.

Setting up vRealize Network Insight Proxy Virtual
Appliance (OVA)
You can set up vRealize Network Insight proxy virtual appliance by importing OVA to your vCenter server.

Follow the steps below to import the vRealize Network InsightProxy OVA to your vCenter Server

Deployment Using vSphere Web Client
You can import the vRealize Network Insight Proxy OVA using vSphere Web Client.

Procedure

1 Right-click on the Datacenter where you want to install the appliance and select Deploy OVF
Template.

2 Browse to select the source location of the appliance OVA.

3 Select the destination folder in which you want to create the VM and give a desired name to the VM.

4 Select a Host/Cluster where you want to run the deployed template.

5 Select the Resource Pool in which you want to deploy this template.

Installing vRealize Network Insight
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6 Verify the OVF template details.

7 Read the End User License Agreement and click Accept.

8 Select the Deployment Configuration.

9 Select the Datastore where you want to store the files.

10 Select Thin Provision as the Virtual Disk format.

11 Select the Network that the deployed VM uses.

12 Customize the template as mentioned as follows:

a (Optional) Web Proxy IP/FQDNand Web Proxy Port: For accessing the Internet using a proxy

b To improve the product by sending anonymous data about product performance, select the
Health Telemetry Enable check box.

c Shared Secret for vRealize Network Insight Proxy: The shared secret generated on the
onboarding page

d IPv4 Address: Second reserved static IP address

e Netmask: Subnet mask for the preceding static IP

f Gateway: Default gateway of your network

g DNS Server List: DNS servers of your environment

Note   For multiple DNS servers, ensure that they are separated by commas.

h (Optional) Domain Search List : Determines which domain to be appended for dns lookups

i NTP Server List: Enter the list of NTP servers and ensure that the NTP Server can be reached
from the VM. The services fail to start if NTP time is out of sync.

Note   For multiple NTP servers, ensure that they are separated by commas.

j Deselect the Log Push Enable check box if you do not want to send diagnostic and
troubleshooting data to VMware.

13 Review the details and click Finish.

14 Switch on the VM manually after the deployment.

Deployment using vSphere Windows Native Client
You can import the vRealize Network Insight Proxy OVA using vSphere Windows native client.

Procedure

1 Click File > Deploy OVF Template.

2 Browse to select the source location of OVA.

3 Verify the OVF template details.

Installing vRealize Network Insight
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4 Read the End-User License Agreement and click Accept.

5 Ensure the desired folder is selected and give a name to the VM.

6 Select the Deployment Configuration.

7 Select a Host/Cluster where you want to run the deployed template.

8 Select the Resource Pool in which you want to deploy this template.

9 Select the Datastore where you want to store the files.

10 Select Thin Provision as the Virtual Disk format.

11 Select the Network that the deployed VM will use.

12 Map the network from OVA to your inventory.

13 Customize the template as mentioned below:

a Shared Secret for vRealize Network Insight Proxy: The shared secret generated on the
onboarding page

b IPv4 Address: Second reserved static IP address

c Netmask: Subnet mask for the above static IP

d Gateway: Default gateway of your network

e DNS Server List: DNS servers of your environment

Note   For multiple DNS servers, ensure that they are separated by commas.

f (Optional) Domain Search List : Determines which domain to be appended for dns lookups

g NTP Server List: Enter the list of NTP servers and ensure that the NTP Server can be reached
from the VM. The services will fail to start if NTP time is out of sync.

Note   For multiple NTP servers, ensure that they are separated by commas.

h (Optional) HTTP Proxy IP/FQDN and HTTP Proxy Port: For accessing the Internet using a proxy

i Deselect the Log Push Enable check box if you do not want to send diagnostic and
troubleshooting data to VMware.

j Select the Health Telemetry Enable check box, to improve the product by sending anonymous
data about product performance.

14 Review the details and select the Power on after deployment check box then click Finish.

Note   After the vRealize Network Insight Proxy OVA is deployed and running, you must verify
whether the given static IP is set on vCenter Server.

15 Click Finish, once Proxy Detected! message is displayed on the onboarding page. It will redirect to
the Login Page.
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Deploy Additional Proxy to an Existing Setup
You can add additional vRealize Network Insight proxy to an existing setup.

Procedure

1 Log into the vRealize Network Insight UI. Navigate to Settings > Install and Support.

2 Click Add Proxy VM.

3 Copy the shared secret from the dialog that is displayed.

4 Follow the steps in section Setting up vRealize Network Insight Proxy Virtual Appliance (OVA) in step
3.

Default Login Credentials
vRealize Network Insight has three types of users. The login credentials for these users are as follows:

Note   Use Google Chrome to log in to vRealize Network Insight.

Table 2‑1.  
Types of Users User name Password

Admin UI admin@local Set this password in the
Activate License window
during installation.

SSH User support ark1nc0113ct0r

CLI User consoleuser ark1nc0ns0l3

Note   It is recommended that the users change the default passwords of the SSH User (support) and
the CLI User (consoleuser) immediately after the deployment.

Procedure

1 Navigate to https://<vRealize Network Insight Platform IP address>.

2 Log in to the product UI with the corresponding user name and password.

NSX Assessment Mode for Evaluation License
vRealize Network Insight starts in the NSX assessment mode when you use the evaluation license.

You can add a data source to vRealize Network Insight, analyze traffic flow, and generate reports.

Note   To switch to the Full Product mode, click Switch to Full Product Evaluation located in the bottom
right corner.

Installing vRealize Network Insight
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Add vCenter Server
You can add vCenter Servers as data source to vRealize Network Insight.

Multiple vCenter Servers can be added to vRealize Network Insight to start monitoring data.

Procedure

1 Click Add vCenter.

2 Click Add new source and customize the options.

Option Action

Source Type Select the vCenter Server system from the drop-down menu.

IP Address/FQDN Enter the IP address or fully qualified domain name of the vCenter Server.

Username Enter the user name, with the following privileges:
n Distributed Switch: Modify
n dvPort group: Modify

Password Enter the password for vRealize Network Insight software to access the vCenter
Server system.

 
3 Click Validate.

4 Select Enable Netflow (IPFIX) on this vCenter to enable IPFIX.

5 Add advanced data collection sources to your vCenter Server system.

6 (Optional) Click Submit to add the vCenter Server system. The vCenter Server systems appear on
the homepage.

Analyze Traffic Flows
You can use vRealize Network Insight to analyze flows in your datacenter.

Prerequisites

At least two hours of data collection must occur before starting the flow analysis.

Procedure

1 Specify the scope of the analysis. For example, if you are interested in flows of all virtual machines in
a Cluster, select Cluster from the dropdown menu. You can alternately select all virtual machines
connected to a VLAN or VXLAN.

2 Select the entity name for which you want to analyze the flows.

3 Select the duration and click Analyze.

Generate a Report
You can generate a report of the flow assessment.

Installing vRealize Network Insight
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Prerequisites

Analyze traffic flows in the datacenter. For comprehensive reports, collect 24 hours of data before the
analysis.

Procedure

1 In the EVAL NSX Assessment Mode, click Generate Report in the Analyze Flows page.

2 In the Non EVAL Mode, on the Microsegmentation page, click Traffic Distribution > More
Options > Assesment Report.

Adding Data Sources
After you log in, add the various data sources to vRealize Network Insight for the software to monitor your
data center.

The product will start showing the data from your environment after two hours of data collection.

Procedure

1 Select Profile > Settings.

2 Click the Add new source button.

3 Select the Source Type.

4 Enter the required details and click Submit to add the Data source.

5 Repeat the above steps to add all the required data sources from your environment.

Installing vRealize Network Insight
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Scaling up of a Platform or
Collector Appliance 3
The process of scaling up of a platform or a proxy appliance implies changing its brick size from MEDIUM
to LARGE.

If a platform is of LARGE brick size, then you have to scale up by adding more platform nodes such as
creating a platform cluster. After a proxy is of LARGE brick size, then you have to add more proxies.

The steps to scale up vRealize Network Insight Virtual Appliance from MEDIUM brick to LARGE brick are as
follows:
1 Log in to vCenter.

2 Increase the RAM of the VM to at least match the LARGE brick size requirements.

3 Increase the vCPU count of the VM to at least match the LARGE brick size requirements.

4 Refer to the brick size in the System Requirements section.

5 Restart the VM.
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Planning to Scale up the
Platform Cluster 4
Three or more LARGE platform bricks can be connected together to form a platform cluster.

Note   Ensure that you take a backup of the Platform1 node before you create clusters. Refer to VMware
best practices to take the backup of virtual machines (like VMware VDP using VADP). Restore the
Platform1 node from backup if there is an unrecoverable error while creating the cluster. It is
recommended that you use cleanly deployed platform nodes while creating clusters. Redeploy the new
platform nodes (p2-pn) before restarting cluster creation process if there is an unrecoverable error.

To decide the required number of platform bricks:

Number of bricks needed = Round off to next Integer ((Total number of managed VMs) /

(Capacity of LARGE Platform brick in table above))

Scaling up Scenarios for the Platform Cluster
n Scenario 1

a Assume that on January 1st (today), the datacenter has 2000 VMs (with flows) across many
vCenters.

b Assume that in March, the number of VMs grows to 3100.

c Assume that in June, the number of VMs grows to 6100 which could be because of the additions
of few more vCenters or the expansion of the existing vCenters.

d Assume that in December, the number of VMs grows to 18100 (with flows).

The deployment model for this scenario is as follows:

a On January 1, deploy a single platform node with the MEDIUM brick size.

b In March, scale up the platform node to the LARGE brick size.

c In June, scale out the platform, convert to a three node platform cluster by adding new Platform
nodes to the existing Platform.

d In December, the user needs a four node platform cluster.

n Scenario 2

a Assume that on January 1st (today), the datacenter has 7000 VMs (with flows) across many
vCenters.
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b Assume that in June, the number of VMs grows to 15000 (with flows).

c Assume that in December, the number of VMs grows to 24000 (with flows).

The deployment model for this scenario is as follows:

a On January 1, deploy a three node platform cluster.

b In June or later, as the environment size gets closer to exceeding 18000, the user needs a four
node platform cluster.

c In December, as the environment size gets closer to exceeding 24000, the user needs a five
node platform cluster.

Installing vRealize Network Insight
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Planning to Scale up the Proxy
Cluster 5
The scaling up of the proxy node is independent of the platform nodes in the cluster. Typically, the users
install one or more proxy VMs per site. Within a site, the number of proxy VMs needed is a simple
function of total number of VMs for which it has to collect data. Refer to the capacity of proxy VMs in the
brick size table in the System Requirements section.

You can add a data source (maybe a vCenter or a switch) to exactly one proxy VM.

Scaling up Scenarios for the Proxy Cluster
n Scenario1: Suppose there are 2000 VMs in a vCenter.

Install one medium proxy VM. Assign the vCenter to this proxy using the product UI.

n Scenario 2: 1000 VMs in vCenter1 and 2000 VMs in vCenter2 (all of them are in one data center)

Install one medium Proxy VM. Assign both vCenters to this proxy using the product UI.

n Scenario 3: 1000 VMs in vCenter 1 and 2000 VMs in vCenter2 (all of them are in the same data
center)

Install one medium Proxy VM. Assign both vCenters to this proxy using the product UI.

n Scenario 4: 1000 VMs in vCenter1 (data center1) and 2000 VMs in vCenter2 (data center2)

Install one medium Proxy VM in each data center. Assign vCenter1 to proxy VM in same data center
using Product UI. Assign vCenter2 to Proxy VM in its data center using the product UI.

n Scenario 5: 9,000 VMs in vCenter1 without flows (data center1)

Install one large proxy brick. Assign this vCenter to this proxy using the product UI.

n Scenario 6: 11,000 VMs in vCenter1 with flows (data center1)

This scenario is not supported. Maximum number of VMs that can be managed by one proxy VM is
10,000 without flows OR 6,000 with flows. And one vCenter can be added to only one proxy at a time.

n Scenario 7: vCenter1 with 2000 VMs in January, vCenter2 with 5000 VMs in June

Install one medium Proxy VM in January and assign vCenter1 to it. Install the second large proxy VM
in June and assign vCenter2 to it.
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Proxy VMs with a Platform Cluster
The number of proxy VMs does not depend on the number of VMs in a platform cluster. All proxy VMs
communicate only to the first platform VM (platform1 in the following example) in a platform cluster. A
few example deployment models that are supported are as follows:

n Case 1: A proxy VM connects to a platform cluster.

The proxy connects to platform1.

n Case 2: Many Proxy VMs connect to a platform cluster

All the proxies are connected to platform1. And then platform1 VM load balances both proxy
requests and the data processing to other platform VMs in this cluster internally automatically.

n Case 3: A proxy VM connects to the single platform node deployment

n Case 4: Many proxy VMs connect to one platform node deployment

Installing vRealize Network Insight
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Expanding a Cluster 6
The cluster expansion feature enables you to add the platform nodes to any existing old and new cluster
without incurring any data loss.

Note   Ensure that you take a backup of all the Platform nodes before you create clusters. Refer to the
VMware best practices to take the backup of virtual machines (like VMware VDP using VADP). Restore
the Platform nodes from the backup if there is an unrecoverable error.

For example, if you have an existing cluster with three nodes, you can add 4 more nodes to it without any
data loss.

Procedure

1 On the Install and Support page, click Expand Cluster for Platform VMs.

2 The IP addresses of the VMs that are part of the cluster already are listed on the Expand Cluster
page. To add one or more nodes to the existing cluster, provide the IP address of the node and the
support user password.

Note  
n Currently, vRealize Network Insight supports 10 nodes in an existing cluster. Once the limit is

reached, the Add more button is disabled.

n Ensure that all the new nodes are non-provisioned and are reachable through SSH.

n Ensure that you have taken a backup of the existing platform VMs before you go ahead with the
cluster expansion.

3 Click Submit.

The step-by-step progress is displayed.

4 Once the cluster expansion link is completed, a message indicating success is displayed.

While the cluster expansion is in progress, the application cannot be used for any other operation.
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Upgrading vRealize Network
Insight 7
You can upgrade your current vRealize Network Insight environment to the latest version.

In vRealize Network Insight, you can upgrade to 3.7 version from the 3.6 version and the 3.5 version from
the same upgrade bundle.

3.5->3.7

3.6->3.7

For other versions of vRealize Network Insight, the upgrade is supported only from the immediately
preceding version. For example, the upgrade to the vRealize Network Insight 3.5 version is supported
only from the vRealize Network Insight 3.4 version.

3.0->3.1->3.2->3.3->3.4->3.5->3.6->3.7

vRealize Network Insight provides the following two modes of upgrade:

This chapter includes the following topics:

n Offline Upgrade

n Online Upgrade

Offline Upgrade
Use this option when both vRealize Network Insight Platform and Proxy VMs do not have access to the
internet. You must upgrade Platform VMs before Proxy VMs.

Prerequisites

In case of the cluster upgrade, platform1 must be upgraded first. To confirm platform1 IP address, run
the ping platform1 command from CLI.

Procedure

1 Download the required upgrade bundle file from My VMware.
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2 Copy the upgrade bundle to vRealize Network Insight Platform and Proxy VMs by using either of the
following options:

a To copy the file from Linux VM to vRealize Network Insight VM, run this command:

scp <filename>.upgrade.bundle consoleuser@<IP_Address_vRNI_VM>:~/

To copy file from Windows VM to vRealize Network Insight VM, run this command:

Note   Use the pscp utility from https://the.earth.li/~sgtatham/putty/latest/w64/pscp.exe.

 pscp -scp <SOURCE_PATH>\<filename>.upgrade.bundle consoleuser@<IP_Address_vRNI_VM>:~/

b Log in to the vRealize Network Insight Platform CLI using consoleuser and run this command:

Note   This command uses SCP to download the bundle from the host where the bundle is
downloaded. So the SCP server is required to be running on the host.

package-installer copy --host <ip address> --user johndoe --

path /path/to/<filename>.upgrade.bundle

3 Upgrade the appliance using the package-installer upgrade command. For the 3.5 version, run
the command as follows:

 package-installer upgrade --name VMWare-vRealize-Network-Insight-<version_number>.upgrade.bundle

For 3.4 and the preceding versions, run the command as follows:

 package-installer upgrade

Note   The upgrade completes within 30 minutes after this step.

4 Verify the upgraded version using the show-version command.

Note  
n Ensure that you verify the checksums for the upgrade bundle as specified.

n You can upgrade the cluster only in the offline mode.

n After a successful upgrade, you do not have to reboot the virtual machine.

Online Upgrade
Whenever there is a new version of vRealize Network Insight available, you will receive a notification.

Installing vRealize Network Insight
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Procedure

1 Check if the update notification is available on the Install and Support page under Settings. For
example:

Updates: A new version <version_number> is available!

Pop Up Notification: Upgrade available!

2 Click View details to view details of update.

3 Click Install Now on the details page to download and upgrade the vRealize Network Insight
deployment.

4 Verify the upgraded version from the product UI under Settings page to be one that is mentioned in
the update.

5 If the update notification is not available, verify that both vRealize Network Insight Platform and Proxy
VMs have connectivity to svc.ni.vmware.com on port 443 and reg.ni.vmware.com on port 443 by
running the show-connectivity-status command.

Note   If this connectivity requires http proxy, configure it on each VM using the set-web-proxy
command.

Ensure that the output contains upgrade connectivity status as Passed.

6 File a support ticket and provide the service tag from the product UI. The service tag is shown under
Settings.

7 Provide a screenshot of the show-connectivity-status command output from each vRealize
Network Insight Platform and Proxy VMs.

After VMware support enables the online upgrade, return to step 1 and 2.

Installing vRealize Network Insight
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